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Introduction 

About the ER-280 Series PC Utility 
The ER-280 Series PC Utility provides basic PC communication functions for 
SAM4s ER-285M.  This utility was designed primarily as a dealer tool - to save, 
edit, and download programs.   

The ER-280 Series PC Utility includes the following features: 

 Multiple Stores 

 Save and Load ECR programs 

 Convert & Download Logo Bitmaps 

 Edit ECR programs 

 Poll and View Register Reports 

 Remote Modem Communication Capability 

Note:  The ER-280 Series PC Utility was developed to work best with a 
screen resolution of at least 1024 x 768 pixels.   
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Getting Started 

Setting the ER-285M RS-232C Port 
At the ER-285M, you must select ‘PC’ as the device that is attached to one of the 
RS-232C communications port. 

If you are using RS-232C Port #1: 

1. Turn the control lock to the S position. 

2. Enter 8 0 and press the SBTL key. 

3. Enter 5 and press the X/TIME key.  (Refer to the RS-232C option chart 
that follows.)   

4. Enter 1 (the value for PC) and press the CASH key.   

5. Press CASH to exit the program.   

 

 

If you are using RS-232C Port #2: 

1. Turn the control lock to the S position. 

2. Enter 8 1 and press the SBTL key. 

3. Enter 5 and press the X/TIME key.  (Refer to the RS-232C option chart 
that follows.)   

4. Enter 1 (the value for PC) and press the CASH key.   

5. Press CASH to exit the program.   

 

 

 

Repeat for another 
Index

XTIME OPTIONSBTL 0 8 CASH VALUE CASH 

Repeat for another 
Index

XTIME OPTIONSBTL 1 8 CASH VALUE CASH 
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If you are using RS-232C Port #3: 

1. Turn the control lock to the S position. 

2. Enter 8 2 and press the SBTL key. 

3. Enter 5 and press the X/TIME key.  (Refer to the RS-232C option chart 
that follows.)   

4. Enter 1 (the value for PC) and press the CASH key.   

5. Press CASH to exit the program.   

 

 

 

Repeat for another 
Index

XTIME OPTIONSBTL 2 8 CASH VALUE CASH 
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RS-232 Option Chart 
N1 OPTION N2 VALUE 

0 9600 BPS 
1 1200 BPS 
2 2400 BPS 
3 4800 BPS 

1 Baud Rate 

 

4 19200 BPS 
0 NONE 
1 ODD 

2 Parity 

2 EVEN 
0 8 BITS 3 Data Bits 
1 7 BITS 
0 1 BIT  4 Stop Bits 
1 2 BIT 
0 NONE 
1 PC 
2 SCALE 
4 RECEIPT PRINTER 
6 SCANNER 
7 COIN 
8 EFT 
9 POLE 

5 Device Function 

10 PDC 
6 Initial Feeding Line KP 0 - 20  
7 End Feeding Line KP 0 - 20  
8 Initial Feeding Line Slip 0 - 20  
9 Print Line On Guest Check 0 - 50  

0 NCI 10 Scale Type 
1 CAS 
0 NONE 
1 SAM4S ELLIX10 
2 SAM4S ELLIX20 
3 SRP-270 
4 SRP-350 
5 CITIZEN3550 
6 CITIZEN810 
7 CITIZEN230 
8 EPSON TMT88-2 
9 EPSON U200 

10 EPSON U295 
11 EPSON U300 
12 EPSON U325 
13 EPSON U375 
14 STAR SP-200 
15 STAR SP-298 
16 STAR SP-300 

11 Printer Type 

17 STAR TSP-200 
0 EPSON 12 Pole Display  
1 ICD 
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Preparing the ER-280 Utility for Communications 
The register must be ready for communications: 

 Connect the register directly to the PC with the appropriate cable.  See 
“Cabling Diagrams” on page 39.   

 The register power must be on. 

 A clerk must be signed on.  

 The register cannot be inside of a transaction.  

 The key lock can be in any position.   

Installing the Utility 
1. From Windows Explorer, locate the file: SETUP280.exe.  Double click 

the file to open the installation dialog box.   

2. Follow the instructions on the screen to complete the installation.    
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Starting the PC Utility 
1. Choose Start, Programs, SHC PC UTILITY and then 280pc.  When 

starting the utility for the first time, the ADD STORE dialog box 
displays.    

 

2. Enter the store name and click OK.  The STORE SETTING dialog 
displays.  If you have already set up at least one store, the STORE 
SETTING dialog box display upon start-up. 

 

3. Select the store you wish to open, select the PORT (COM1-COM8), 
select the BAUDRATE (9600 or 19200) and click the Close button.  The 
ER-280 Series PC Utility window opens for the selected store.   
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Store Settings 
There is no limit to the number of stores.  When you start the utility for the first 
time, enter the store name and select the PC port and baud rate. 

The Store Setting Dialog Box 

 

Selecting a Store 

 Select the working store when you start the utility.   

 To change the working store after the utility has been started, choose 
Setup Store from the Setup menu and select a different store from the 
drop-down list box.   

Adding a Store 

 Choose Add Store from the Setup menu.  At the Add Store dialog, 
enter the store name and click OK.  At the Store Setting dialog, select 
the PC port, baud rate and click the Close button.    

Removing a Store 

 Choose Remove Store from the Setup menu.  At the Remove Store 
dialog, select the store name to remove and click OK.   

Using a Modem 

 Choose Use Modem check box and enter the phone number of the store 
in the Phone Number field.   
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Upload/Download Programs 

UpProgram 

You must upload a program before program edit functions are 
allowed.  If you wish to programming at the PC, first upload all 
programs from a RAM-cleared ECR.   

 Select the program segment you wish to upload from the UpProgram 
menu, or select All Program to upload the entire register program 
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DownProgram 
Downloading a program will overwrite the existing register program.  

 Select the program segment you wish to download from the 
DownProgram menu, or select All Program to download the entire 
register program (not including PreAmble and PostAmble images, that 
are downloaded separately.)   
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Edit Programs 

Procedures 
With the exception of memory allocation (which can be viewed, but not 
changed), all register programs can be edited with the PC Utility.  You will find 
options neatly organized on dialog boxes, making register option programming 
on the PC Utility more efficient than programming options at the register.   

NOTE:  You must upload a program before program edit functions are allowed.   

1. To edit a program, choose the appropriate program from the EditProgram 
menu.  An example of each program dialog box is shown in this chapter.   

2. After edits, click Save to exit and save changes, or click Cancel to exit 
without saving changes.   

Tips 
 Each Store’s data, including both uploaded program files and polled report 

files, is located in a separate folder under the ER-280PC folder.   

 If you are building a new register program based upon an existing store, you 
can copy an existing store’s program files to a new store folder.  It is often 
more efficient to modify an existing program than to start over with a new 
one.   

 If you are building a large PLU file with identical (or similar) options for 
each PLU, you may find the from/to PLU programming at the register useful.  
For example, you can first program the identical options for a range of PLUs 
at the register.  Then upload the PLU program with the utility.  Use the utility 
to program descriptors, prices and make adjustments to each PLU 
individually.  Finally, you can download the completed program to the 
register.   

 If you have questions regarding the meaning of ECR features, refer the 
appropriate ER-285M Program and Operation manual for an explanation of 
your program options.   

Note:  When editing descriptor fields, you can make bold characters print 
on the ECR by entering a tilde () before each character.  Each bold 
character occupies 2-character positions.   
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Program Edit Screens 

PLU 

 

Groups 
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Tax 

 

System Option 
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Print Option 

 

Function Key 
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Clerk  

 

Logo/Descriptors 
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PLU STOCK 

 

NLU 
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Macro 

 

Key Layout 

Note:  To see the entire keyboard on the screen, the screen resolution must 
be set to 1024 x 768 pixels.   
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Comm Port 

 

Mix & Match 
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Etc. – Tare/Drawer Limit/Change Limit/Machine 
Number 

 

Memory Allocation 
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Reports 

Poll Reports 
 Select the report you wish to poll from the PollReport menu.    
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Report File Conventions 
Polled reports are stored in a folder named with the current date, located in a 
folder under the store name.  For example:   

 C:\ER-280PC\Storename\041207 

Where 041207 is the date the reports were polled, April 12, 2007.   

Reports listed in this folder are named using the following convention: 

C L K 0 2 0 0 7 0 4 1 2 1 1 3 4 4 9 . r e p  

      Report type: Clerk (CLK), financial 
(FIN), PLU, group (GRP) 

      Report mode:  0=X1; 1=X2; 3=Z1; 4=Z2 

      Year (YYYY) 

      Month (MM) 

      Day (DD) 

      Time (HHMMSS) 
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View Reports 

SAM4s ER-280 series reports are saved in .RPT format.  These files are not 
ASCII and cannot be directly read by a report editor.  However, with this 
utility, you can view the report data, export it to Microsoft Excel, and/or 
export it to a text file.   

1. Select the type of report you wish to view from the ViewReport menu. 

 

2. The File Associate dialog displays.  Click the Browse ( … )button to locate 
the report you wish to view.   
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3. Select the report you wish to view.  Note that report you select must match 
the type of report you selected from the menu.  For example, if you selected 
PLU from the ViewReport menu, you must select a report file that begins 
with the text “PLU …”; if you selected FINANCIAL from the ViewReport 
menu, you must select a report file that begins with the text “FIN…” 

 

4. Click Open.  The selected report displays.   
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5. Choose Setting to select zero skip options.  Click OK to close the dialog and 
return to the financial report window.   

 

6. From the report window, choose: 
 
Print:  to print the file at your printer 
Export to Excel: to save the report in text (.xls) format 
View on Excel: to open Excel and view the file 
Export to Text:  to save the report in Excel (.txt) format 
File Associate:  to select a new financial report 
Close:  to exit 
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Prepare & Load Bitmap Logos 

Preparing a Graphic Logo Bitmap for an ER-285M 

The image must be black/white, 256 x 192 pixels, and 10 Kbytes or less in 
size. 

1. Open MS Paint. 

2. Open the image file you wish to use.   

3. Choose Attributes from the Image menu.  The Attributes dialog box 
displays. 

 

4. The image dimensions must be no larger than 256 pixels wide by 192 
pixels high.  If the image size in pixels is greater than the maximum, you 
must resize your image.   

a. Click OK to exit the Attributes dialog. 

b. Select your image.  (Choose Select All from the Edit menu.) 

c. Using the handles of the selected image, resize the image.  Keep the 
image in the upper left corner of the screen.   

d. Choose Attributes from the Image menu.  The Attributes dialog 
box displays again.  Enter 256 in the Width field; enter 192 in the 
Height field; select Pixels as the unit.  Click OK to exit the dialog 
box.   

e. Your image will be cropped to the 256 x 192 pixel size.  If you 
cropped part of the image you wish to keep, you can undo (Ctrl + Z) 
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and try again.  You may have to experiment a bit to resize the image 
inside the 256 x 192 pixel limit.   

5. After the image is sized, select Black and white in the Attributes 
dialog. 

6. Save your image as type “Monochrome Bitmap (*.bmp,*.dib)” and 
confirm that the size is 10k or less.  If you resized your original image, 
you may wish to rename when you save, so that you preserve a copy of 
the original image.   

Download a Graphic Logo to an ER-285M 
1. Install the ER-280 PC Utility on your PC. 

2. At the ER-285M, set the RS-232C option address #5 to a value of 1 
(PC).   
(S position; 80 SBTL; 5 X/TIME; 1 CASH; CASH, or  
S position; 81 SBTL; 5 X/TIME; 1 CASH; CASH, or  
S position; 82 SBTL; 5 X/TIME; 1 CASH; CASH) 

3. Return key lock to REG and sign on a clerk.     

4. Connect the PC to the ER-285M using one of the following cables: 

CRS Part # 522126 (Register DB-9M to PC DB-9F) 

CRS Part # 522038 (Register DB-9M to PC DB-25F) 

CRS Part # 522124 (For port #3 Register RJ45 to PC DB-9F) 

5. At your PC, start the ER-280 PC Utility.  (Select Start, Programs, 
SHC PC UTILITY, ER-280 PC UTILITY.)  The Store Setting 
dialog box displays.   

6. If you are starting the ER-280 PC Utility for the first time, you must 
define a store name, or if a store is already defined, you can select the 
store from the drop down list.  After the store is defined or selected, 
click Close.  The PC Utility program starts.   

7. Move the .bmp logos you wish to use into the store directory  
(i.e. C:/ER-280PC/storename.) 

8. At the PC Utility, choose Convert Logo Image from the Utility menu.  
The Bmp dialog box displays.   

9. Click FILE OPEN.  Select the bitmap image you wish to use from the 
Open dialog and click the Open command button.  

10. Click the SAVE AS PRE IMG or SAVE AS POST IMG button. 
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11. When the image is selected, click OK.  Verify that the message “Save 
As UserPre.Img” or “Save As UserPost.Img” displays.  If the file is too 
large, and cannot be loaded, the message “File Size Error” display.   

12. Choose PreAmble Image or PostAmble Image from the 
DownProgram menu.   

13. The screen will track the progress of the download.  When complete, 
the COMPLETED message will display, click OK.  

Printing the Logo Image – ER-285M Settings 
Options in Print Option Programming must be set to enable graphic logo 
printing.  You can set these options at the register, or through the PC Utility.   

To set the Logo Print through the PC Utility 
1. Choose Print Option from the Edit Program menu. 

 

2. Select “PRE-PRN GRAPHIC LOGO ON RECEIPT” and or “POST-
PRN GRAPHIC LOGO ON RECEIPT”.  De-select “PRE-PRN LOGO 
IS DEFAULT” or “POST PRN LOGO IS DEFAULT” as needed.   

3. After edits, click Save to exit and save changes. 
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To set the Logo Print through the Register 
 Turn the key lock to the P position and use the flowchart to set options #28 

and #30 as needed.   

Option #28 – Add the value of 1 to address 28 if you wish to print the pre 
graphic logo on the receipt.  Add the value of 2 to address 28 if you wish to 
print the post graphic logo on the receipt.   

Option #30 – Add the value of 1 to address 30 if you wish to print your custom 
bitmap instead of the default bitmap “Thank You – Your Receipt”.   

Print Option Flowchart (P Key Lock Position)  

 

 

 

 

 

Status

Option #

SBTL X/TIME  CASH 

Repeat for each Print 
Option 

  SBTL 0 4 
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Import/Export PLU Files 

PLU PGM to Excel/PLU Excel to PGM Utilities 
Import/Export utilities are available in the ER-280 PLU Utility Version 01.010 or 
later.  

This feature of the SAM4s ER-285 PC Utility is found under the Utility tab.  
Select “PLU PGM TO EXCEL” or “PLU EXCEL TO PGM”.   

 When the “PLU PGM TO EXCEL” utility is run, the Excel file is place into 
the folder:  C:\ER-280PC\Storename.  The file is named PLU.csv.   

 When the “PLU EXCEL TO PGM” utility is run, the PLU.csv file in the 
folder:  C:\ER-280PC\Storename will replace the PLU file to the register 
folder.   

PLU Key for CSV Import/Export 
 
 

 

Example of Exported CSV File (in Excel):
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Excel PLU.csv Key 

Column on PLU.csv Corresponding Option 

A PLU #: 
B DESCRIPTOR 
AI PRICE/HALO 1 
AJ PRICE/HALO 2 
F PRESET 
G PRESET OVERRIDE 
H TAXable By: 1 
I TAXable By: 2 
J TAXable By: 3 
K TAXable By: 4 
L FOOD STAMP ELIGIBLE 
M NEGATIVE ITEM 
N HASH 
O SINGLE ITEM 
P NON-ADD # COMP. 
Q GALLONAGE ITEM 
R INVENTORY ITEM 
S DISABLE 
T SCALEABLE 
U AUTO SCALE 
V CONDIMENT 
W COMP. CONDIMENT 
X PRINT ON RECEIPT 
Y * 
Z PRINT ON CHECK 

AA PRINT PRICE ON RECEIPT 
AB PRINT PRICE ON CHECK 
AC DISABLE PROMO 
AD COUNTER NOT RESET 
AE PRESET OVERRIDE IN       

MANAGER CONTROL 
AF AUTO TARE (1-5) 
AG LINK PLU 
C GROUP # 1 (1-20) 
D GROUP # 2 (1-20) 
E GROUP # 3 (1-20) 

AH LINK M&M TABLE # 

*Y column in the PLU>csv file is always “Y”.  
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PLU Key Viewed on Utility PLU Program Window 
 

 

A
B 

H

E 

G 

J K

L

C

I 

D 

F

AF

AH

AG 

N
P
R

AA
X
V
T

AC

M
O
Q
S
U
W

AE
AD
AB
Z

AJ

AI
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Import Note – Notation of Large PLU Numbers 

Using default Microsoft Excel settings, numbers exceeding 12 digits will 
display in scientific notation as shown in the sample sheet below: 

 

Caution   If you are editing a PLU.csv file in Excel, and you are using large PLU 
numbers (such as 14-digit UPC numbers), you must take care to change the 
formatting of the number in Excel, so that the correct PLU number is sent to 
the PLU file.   

To Change PLU Number Display in Excel 

1. On the Excel spreadsheet, select column “A” (the PLU number column). 

2. Choose Cells from the Format menu.  The Format Cells dialog box 
displays with the Number tab selected.  Note the the Category selected 
is “General”.   
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3. Select the ‘Number” category and set the Decimal places field to “0”.   

 

4. Click OK to save the settings.  Note the large number now displays 
completely, without scientific notation.   
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Appendix 

Cabling Diagrams 
You can configure cables yourself with the diagram provided here, or you can order the 
appropriate cables from CRS Parts at 1-800-333-4949.   

Direct Connection 
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Manual Revision Record 

 

Edition Date published Revison contents 

V1.1 7/9/2007 Initial Publication 
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PGM utility.   

   

   

   

   

 

 


